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INTRODUCTION

The Bluetooth® wireless technology provides short-range wireless communications that replace the physical
cable connections that traditionally link electronic devices.

• Network access points 

• Computers (desktop, notebook, PDA, etc.)

• Imaging devices (printer, camera)

• Audio devices (headset, speakers)

Bluetooth wireless technology also enables communication between the above devices and Bluetooth-
enabled phones (example: cellular, cordless, smart phones).

The Bluetooth for Windows software consists of the following components:

• Microsoft® Windows® Explorer Extensions - provides access to Bluetooth devices in the immediate
vicinity using Windows Explorer.

• My Bluetooth Places - graphical user interface (GUI) that provides access to Bluetooth devices in the
immediate vicinity. Also provides access to configure the local devices and access to perform other
Bluetooth tasks.

• BTTray Security Manager - controls and manages Bluetooth security levels. Enables user to grant or deny
access and to filter what can be accessed on a Bluetooth device.

• Bluetooth for Windows Configuration Panel - configures Bluetooth for Windows (BTW) software using
Windows Control Panel.

• Stack Server - provides an interface for the operating system to control Bluetooth devices and to ensure
that Bluetooth connections operate together correctly. The stack server has a built-in Security Manager
that protects the Bluetooth device from unauthorized access.

• Bluetooth Setup wizard - facilitates the configuration and modification of Bluetooth environment. The
wizard can be used to configure or change local services or to establish connections to remote devices
based on service type or device type.

• Quick Connect - facilitates fast connections based on service type. Enables user to quickly find devices
that support a particular service and establish a connection to that service. During this process, a shortcut
to the service is created in My Bluetooth Places, which can be used for subsequent connections.

BLUETOOTH TRAY

The Bluetooth tray resides in the notification area, at the far right of the taskbar. The Bluetooth tray provides
fast access to most Bluetooth operations.

From the Bluetooth tray the user can:

• Access My Bluetooth Places—double-click the Bluetooth icon, or right-click the Bluetooth icon and then
select Explore My Bluetooth Places.

• Access the Bluetooth Setup Wizard. This wizard enables the user to:

• Configure how this computer accesses a service on another Bluetooth device

• Locate remote Bluetooth devices

• Configure the way that this computer provides services to remote Bluetooth devices

• Set the name and type of this Bluetooth device, e.g., John's PC and Desktop.

• Access the Bluetooth Configuration Panel—right-click the Bluetooth icon, and then select Advanced
Configuration.
Broadcom Corporation
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• Access the Quick Connect option—right-click the Bluetooth icon, select Quick Connect, and then select
the type of service to which you wish to connect.

• Start/Stop Bluetooth on this computer.

ACCESS MY BLUETOOTH PLACES

My Bluetooth Places is part of Windows Explorer.

There are multiple ways to access My Bluetooth Places:

• In the Notification area, at the far right of the taskbar

• Right-click the Bluetooth icon and select Explore My Bluetooth Places
or

• Double-click the Bluetooth icon

• On the desktop

• Double-click the Bluetooth icon

• From Windows Explorer, select My Bluetooth Places in the Folders pane or from the Address shortcut
menu.

BLUETOOTH ICONS

NOTIFICATION AREA ICON

The Bluetooth icon in the notification area, at the far right of the taskbar provides feedback about Bluetooth
status.

DEVICE AND SERVICE ICONS

Bluetooth device and service icons provide at-a-glance feedback about a device or service status by changing
their appearance.

Device Icons

Devices are physical things, such as computers, cameras, headsets, etc. Devices can be represented by icons
in My Bluetooth Places.

Table 1:  Bluetooth Icon

Enabled Disabled Connected

Blue with White Blue with Red Blue with Green
Broadcom Corporation
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Device icons have three states:

• Normal - this unadorned icon indicates the presence of a device in the vicinity. Each type of device is
represented by a different icon. For example, the icon to the right represents a desktop computer in a
normal state. 

• Connected - devices that are connected to this computer are represented by an icon with a green tint and/
or a small butting arrows box added to them ( ). For example, the icon to the right represents a
desktop computer that is connected via Bluetooth to this computer.

• Paired - devices that are paired with this computer are represented by a normal icon with a small check
box added to it ( ). For example, the icon to the right represents a desktop computer that is paired with
this computer.

There are some differences between the device icons used by Windows 9x, ME, and 2000, and those used by
Windows XP. For the device icons used by your system, see Table 2 or Table 3.

Table 2:   Device Icons for Windows 98, Windows Me, and Windows 2000

Name Normal Connected Paired

Audio Gateway

Imaging Device

Desktop Computer

Headset

Human Interface Device 
Keyboard

Human Interface Device 
Mouse

Laptop

Modem

Network Access Point

Personal Digital Assistant

Printer

Telephone
Broadcom Corporation
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Unknown

Table 3:  Device Icons for Windows XP

Name Normal Connected Paired

Audio Gateway

Imaging Device

Desktop Computer

Headset

Human Interface Device 
Keyboard

Human Interface Device 
Mouse

Laptop

Modem

Network Access Point

Personal Digital Assistant

Printer

Telephone

Unknown Device

Table 2:   Device Icons for Windows 98, Windows Me, and Windows 2000 (Cont.)

Name Normal Connected Paired
Broadcom Corporation
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Service Icons

Services are what a Bluetooth device can do for other Bluetooth devices, such as provide access to a local
area network, or the ability to send a fax.

Some devices, such as headsets or network access points, may provide only a single service. Others, such
as desktop and laptop computers, can potentially provide all of the Bluetooth services.

Single-service devices often use virtually the same icon for the service as that used for the device. For
example, the headset service icon is identical to the headset device icon.

Multiservice devices use a different icon for each service that they provide.

Service icons have three states:

• Normal - this type of unadorned icon indicates that a specific service is potentially available from the
selected device. For example, the icon to the right indicates that the Bluetooth serial port service may be
available. 

• Connected - this type of icon indicates that this computer is connected to this service. The icon has a
green tint and/or a small butting arrows box added to it ( ). For example, the icon to the right indicates
that this computer is connected to the Bluetooth serial port service of the remote device. 

• Not Available - this type icon indicates that the service that it represents is not available. Services that are
not available are represented by a normal icon with a small X box added to it ( ). For example, the icon
to the right indicates that the Bluetooth serial port service is not currently available. 

There are some differences between the service icons used by Windows 9x, ME, and 2000, and those used
by Windows XP. For the service icons used by your system, see Table 4 or Table 5.

Note: A service may be unavailable because it (or the required hardware) is in use, or because the
required hardware is not installed. Example: if the fax modem is busy, or not installed, then the fax
service will be unavailable, even though Bluetooth supports that service.
Broadcom Corporation
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Table 4:  Service Icons for Windows 98, Windows Me, and Windows 2000 

Name Normal Connected Not Available*

Audio Gateway

Imaging

Dial-up Networking

Fax

Headset

Network Access

PIM Item Transfer

PIM Synchronization

File Transfer

Serial Port

*Services may be unavailable because they are in use or because the necessary hardware is not installed.
Broadcom Corporation
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Table 5:  Service Icons for Windows XP

Name Normal Connected Not Available*

Audio Gateway

Imaging

Dial-up Networking

Fax

Headset

Network Access

PIM Item Transfer

PIM Synchronization

File Transfer

Serial Port

*Services may be unavailable because they are in use or because the necessary hardware is not installed.
Broadcom Corporation
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BASIC OPERATIONS

START OR STOP BLUETOOTH

To start Bluetooth - in the notification area, at the far right of the taskbar, right-click the Bluetooth icon and
select Start the Bluetooth Device. The Bluetooth icon is blue in color with a white insert when Bluetooth is
running.

To stop Bluetooth - in the notification area, at the far right of the taskbar, right-click the Bluetooth icon and
select Stop the Bluetooth Device. The Bluetooth icon is blue in color with a red insert when Bluetooth is
stopped. 

CREATE A CONNECTION FROM THE BLUETOOTH ICON IN THE SYSTEM TRAY

In the notification area, at the far right of the taskbar, right-click the Bluetooth icon, select Quick Connect and
then select the desired Bluetooth service.

If this computer has created a connection to the desired type of service in the past, the options on the shortcut
menu are:

• The name(s) of any device(s) with which prior connections to this type of service have been established.
Select a name from the list to re-establish the connection.

• Other Devices - select this option to search for additional devices that potentially provide the desired
service, select a device from the list, and then click Connect.

If this computer has never created a connection to this type of service, the only option on the shortcut menu is
Find Devices. Select this option to search for devices that potentially provide the desired service, select a
device from the list, and then click Connect.

CREATE A CONNECTION USING THE BLUETOOTH SETUP WIZARD

To open the setup wizard:

• From the Notification area, at the far right of the taskbar - right-click the Bluetooth icon and select
Bluetooth Setup Wizard.

or

• From Windows Explorer, select My Bluetooth Places, and then from the Bluetooth menu, select Bluetooth
Setup Wizard. 

Follow the on-screen instructions.

Note: Depending on the installed operating system and how Windows Explorer is configured, there
may also be double-click and/or right-click options available to access the Bluetooth setup wizard.
Broadcom Corporation
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CREATE A CONNECTION FROM ENTIRE BLUETOOTH NEIGHBORHOOD

1. From Windows Explorer, in the Folders pane, select My Bluetooth Places, and then select Entire Blue-
tooth Neighborhood.

2. In the right pane of My Bluetooth Places, right-click a device name, and then select Discover Available 
Services.

If a prior service discovery was performed on the selected device, the services that were found will be listed in
the device’s shortcut menu. 

If the selected device has added or reconfigured a service, or if the desired service is not an option in the
shortcut menu, select the Discover Available Services option to update the list of services offered by the
device.

FIND BLUETOOTH DEVICES

Search for Devices looks for Bluetooth devices in the vicinity and displays the devices that it finds in My
Bluetooth Places.

To start a search for devices, in the Folders pane of My Bluetooth Places, select Entire Bluetooth
Neighborhood, and then, from the Bluetooth menu, select Search for Devices.

Periodic Search for Devices

Bluetooth can be configured to search automatically for devices on a regular basis (Bluetooth Configuration
Panel > Discovery tab).

One of the advantages of Bluetooth is the mobility that the wireless connections allow. However, mobility
means that devices may move in or out of connection range during the time between the automatic updates
performed by Bluetooth. To be certain that the displayed list of devices in the neighborhood is current, or if
automatic periodic inquiry is not enabled, force an update of the device list using the technique described in
Search for Devices, above.

Some devices within connection range may not show up in the list of devices found because:

• The device is configured to report only specific types or classes of devices (Bluetooth Configuration Panel
> Discovery tab, on your device).

• The unlisted device is configured to be nondiscoverable. Refer to the unlisted device’s documentation for
assistance in making that device discoverable.

Note: The Bluetooth menu is only visible when My Bluetooth Places is active.

Note:  If you enable the periodic search for devices feature you may experience some performance
degradation while the search is in process, depending on the type of system you have.
Broadcom Corporation
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Find A Service

The process of determining the services that a device provides is called Service Discovery.

To initiate a Service Discovery, in My Bluetooth Places, right-click a device name and then, from the shortcut
menu, select Discover Available Services.

Bluetooth services are those things that this computer can do for remote Bluetooth devices. For example, if
this computer allows a remote Bluetooth device to send a fax using a fax modem that is physically attached to
this computer, then this computer is providing the Bluetooth fax service.

Some services are hardware dependant; for example, this computer cannot provide the fax service unless it
has a physical fax modem.

Some Bluetooth services use virtual hardware. The Bluetooth Serial Port service, for example, does not use a
physical port on this computer. Instead, it creates virtual serial ports that Windows applications can see and
use as if they were actual physical ports.

Each Bluetooth service that this computer is capable of providing can be started automatically when Bluetooth
starts. Each service can be set up to require security measures before allowing a remote Bluetooth device to
connect.

Bluetooth services require a Bluetooth application on the remote device; services and applications usually
have coinciding names; i.e., there is a Bluetooth Fax Service and a Bluetooth Fax Application.

The services supported by Bluetooth are:

• Bluetooth Imaging - allows a remote device to send and receive images (BMP, GIF, PNG, & JPG) to this
computer. Images are stored in the Bluetooth exchange folder.

• Bluetooth Serial Port - allows a wireless connection between two devices. This connection can be used by
applications as though a physical serial cable connected the devices.

• Dial-up Networking - allows a device to use a modem that is physically attached to another Bluetooth
device.

• Fax - allows a device to send a fax using a remote Bluetooth cell phone, modem, or computer.

• File Transfer - allows a device to perform file system operations on another Bluetooth device: browse,
open, copy, etc.

• Headset - allows a Bluetooth headset to be used as the audio input/output mechanism for another
Bluetooth device, such as a computer or cell phone.

• PIM Item Transfer - allows two Bluetooth devices to exchange Personal Information Manager data such as
business cards, calendar items, email messages, and notes.

• PIM Synchronization - allows two Bluetooth devices to synchronize their Personal Information Manager
data. 

• Network Access - allows a device to access a Local Area Network via a second Bluetooth device that is
physically connected to the network or allows a remote device to become part of an ad hoc network
provided by the Bluetooth server.

• Audio Gateway - allows the microphone/speakers on a Bluetooth device (typically a computer) to be used
as the audio input/output mechanism for a remote Bluetooth device, such as a cell phone.

All Bluetooth servers do not necessarily provide all of these services. For example, network gateways may only
provide the Network Access service.
Broadcom Corporation
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Bluetooth Connection Status

The Bluetooth Connection Status dialog box displays information about the state of a connection and provides
a means to disconnect an active connection.

Display the Connection Status dialog box - in My Bluetooth Places, select a device, and then, in the right pane
of My Bluetooth Places, right-click a service name and select Status from the shortcut menu.

The Information provided is:

• Status - Connected or Not Connected.

• Device Name - the name of the device to which this computer is connected.

• Duration - the length of time that this connection has been established, displayed in hours, minutes and
seconds. Depending on the service, the connection may time out (automatically disconnect) after a
specific period of inactivity.

• Activity - the number of bytes sent and received over the connection.

• Signal Strength - a graphic indicator that ranges from Too Weak through Good to Too Strong. 

The controls in the Bluetooth Connection Status dialog box are:

• Properties button - displays the Bluetooth Properties dialog box for this connection.

• Disconnect button - closes this connection.

• Close button - closes the Bluetooth Connection Status dialog box.

Send to Bluetooth

This feature is used to send information to another Bluetooth device. Data types include:

• Files from Windows Explorer

• Documents from Microsoft Office applications, including:

• Word

• Excel

• Access

• PowerPoint

• Microsoft Outlook items, including:

• Contacts

• Appointments

• Tasks

• Messages

• Notes

• Microsoft Internet Explorer:

• Entire web pages

• Individual images

To use Send to Bluetooth (except Internet Explorer)

Note: To change the power transmission level of this computer: from the Bluetooth Configuration
Panel, Hardware tab, click the Advanced button, and then change the setting in the Maximum Power
Transmission drop-down list. The Advanced button is not available in all countries.
Broadcom Corporation
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1. In the application:

• Windows Explorer - select one or more files to be transferred. Folders cannot be transferred.

• Microsoft Office - only the document in the active window can be transferred.

• Microsoft Outlook - select one or more items to be transferred.
2. From the File menu, select Send To, and then select Bluetooth from the shortcut menu.
3. Select a device from the shortcut menu to send the data

or
Select Other..., choose a device from the list, and then click OK to send the data.

Send via Bluetooth from Internet Explorer

Send an entire web page:

1. From the Tools menu, select Send To Bluetooth (or click the Bluetooth icon on the toolbar)
2. In the Select Device dialog box, choose a device and then click OK.

Send a selected image:

1. Right-click the image to be transferred and select Send To Bluetooth from the popup menu.
2. In the Select Device dialog box, choose a device and then click OK.

CONFIGURE BLUETOOTH

ACCESS THE BLUETOOTH CONFIGURATION PANEL

The Bluetooth Configuration Panel provides access to settings for Bluetooth services, client applications,
hardware, security, discovery, accessibility, default paths, event notification, and other Bluetooth related items.

To Open the Bluetooth Configuration Panel

• From the Windows Control Panel, select Bluetooth Configuration
or

• In the Notification area, at the far right of the taskbar, right-click the Bluetooth icon, and select Advanced
Configuration from the shortcut menu.

Bluetooth Services versus Bluetooth Applications

Bluetooth Services are services that this computer provides to remote Bluetooth devices. The Bluetooth
services on this computer are referred to collectively in the Bluetooth configuration panel as Local Services.

Bluetooth Applications are software applications on this computer that allow this computer to use the Bluetooth
services that are provided by remote devices. The Bluetooth applications on this computer are referred to
collectively in the Bluetooth configuration panel as Client Applications.

Bluetooth Services and Bluetooth Applications usually have coinciding names; e.g., there is a File Transfer
service and a File Transfer client application.

How this computer provides a service to remote devices is configured on the Local Services tab of the
Bluetooth configuration panel.
Broadcom Corporation
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How this computer uses a service that is provided by a remote device is configured on the Client Applications
tab of the Bluetooth configuration panel.

BLUETOOTH EXCHANGE FOLDER

This is the highest-level directory on this computer to which a remote Bluetooth device has access.

Devices that have been granted access to the Bluetooth exchange folder also have access to all subfolders
contained within that folder and all files in those subfolders.

GENERAL CONFIGURATION SETTINGS

General Configuration Settings

The settings on the General tab of the Bluetooth Configuration Panel determine information that is displayed
to remote devices.

Identity

• Computer Name - enter a unique name to identify this computer to other Bluetooth devices in the vicinity;
this field cannot be left blank.

• Computer type - select either Desktop or Laptop from the shortcut menu to set the type of icon remote
devices will use to represent this computer.

BLUETOOTH APPLICATIONS

Overview

Some built-in Bluetooth applications provide full functionality for a specific task, such as locating other
Bluetooth devices or synchronizing two Personal Information Managers. 

Other built-in Bluetooth applications provide a way for standard Windows applications to accomplish their tasks
wirelessly. For example, a Bluetooth application may create a wireless serial connection between computers
or provide wireless access to the Internet.

The difference between Bluetooth Applications and Bluetooth Services:

• Bluetooth Applications are software programs on this computer that allow this computer to use the
Bluetooth services that are provided by other devices. In the Bluetooth configuration panel, these
programs are referred to collectively as Client Applications.

• Bluetooth Services are software programs on this computer that provide a service to other devices. In the
Bluetooth configuration panel, these programs are referred to collectively as Local Services.

Note: The Bluetooth exchange folder is shared by the PIM Item Transfer and the File Transfer
services and can be configured from the Properties page of either of those services. When the
Bluetooth exchange folder is reconfigured for either of these services, the other service will be
updated to use the new location. This is also shared by the Imaging service.
Broadcom Corporation
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General Configuration

All of the built-in Bluetooth applications allow you to rename the application and/or require a secure connection
when using the application.

To access the configuration properties page for a built-in Bluetooth application:

• In the Notification area, at the far right of the taskbar, right-click the Bluetooth icon and select Advanced
Configuration from the shortcut menu
or

• From Windows Control Panel, select Bluetooth Configuration

In the Bluetooth configuration panel, Client Applications tab, highlight the application to be configured, and then
click Properties (or double-click the application).

Human Interface Device

Overview

The Human Interface Device (HID) Application allows this computer to wirelessly use one or more remote
Bluetooth HIDs as input/output devices. 

For example, the HID Application allows this computer to use a Bluetooth keyboard and a Bluetooth mouse.

Create a HID Connection

Open a connection to a Bluetooth Human Interface Device using one of these techniques:

• From My Bluetooth Places

• Using the Bluetooth Setup Wizard

• Once a HID connection is established, that connection will persist. If the computer is shut down, when the
computer is turned on again the connection will reestablish automatically.

Close a HID Connection

Under normal circumstances, there is no reason to close a HID connection; once established the connection
is maintained automatically, even during the power off and power on processes.

Note: Client Applications and Local Services usually have coinciding names; e.g., there is a Fax
service and a Fax application.

Note: Some HIDs have multiple modes. Before establishing a connection, be sure the HID is in the
appropriate mode. For example, in the case of a HID that can function as both a mouse and a laser
pointer, be sure the mode switch is set to Mouse before attempting to connect.

Note: HIDs usually have a button, which is sometimes difficult to find, that must be pressed before
other Bluetooth devices can locate the HID. Even after the button is pressed, the HID can be
discovered only for a limited time, and then the button must be pressed again. The time period can
be as short as 30 seconds or as long as 180 seconds. Read the documentation that accompanies
the HID before you attempt to connect to the device.
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If, for some reason, the connection must be closed: from My Bluetooth Places, right-click the service name,
and from the shortcut menu, select Disable.

When a HID connection is closed manually by the operator, the connection’s persistence is broken. The
connection must be re-established manually, after which the connection will again persist until broken
manually.

Configure

No configuration is necessary.

Audio Gateway

Overview

The Audio Gateway Application allows a remote Bluetooth device to use this computer’s microphone and
speakers as the remote device’s audio input and output devices.

Create an Audio Gateway Connection

Open a connection to the Audio Gateway service that is provided by another Bluetooth device using one of
these techniques:

• Notification area, at the far right of the taskbar, Bluetooth icon

• From My Bluetooth Places

• Using the Bluetooth Setup wizard

Close an Audio Gateway Connection

If the connection was established from the Bluetooth icon in the Notification area, at the far right of the taskbar;
click the Bluetooth icon, select Quick Connect, Audio Gateway and then select the device that is providing the
service (active connections have a checkmark in front of them).

or

No matter how the connection was created, in My Bluetooth Places, right-click the service name and select
Disconnect.

Configure

The Bluetooth Configuration Panel > Client Applications > Audio Gateway > General tab provides options to
configure:

• The application name - to change it, highlight the existing name and enter the new name.

• Secure connection - to enable secure connection, select the option box. To disable secure connection,
clear the option box.
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Bluetooth Serial Port

Overview

The Bluetooth Serial Port application allows this computer to establish a wireless serial connection with a
remote Bluetooth device.

The applications on both this computer and the remote device must be configured to send and receive data to
and from the respective communications port (COM port) assigned to the Bluetooth serial port. The wireless
serial connection may then be used by the applications as though a physical serial cable connected the
devices.

Create a Bluetooth Serial Port Connection

Establish a connection using one of these techniques:

• Notification area, at the far right of the taskbar, Bluetooth icon

• From My Bluetooth Places

• Using the Bluetooth Setup Wizard

Close a Bluetooth Serial Port Connection

If the connection was established from the Bluetooth icon in the Notification area, at the far right of the taskbar;
click the Bluetooth icon, select Quick Connect, Bluetooth Serial Port and then select the device that is providing
the service (active connections have a checkmark in front of them).

or

No matter how the connection was created, In My Bluetooth Places, right-click the service name and select
Disconnect.

Configure

The Bluetooth Configuration Panel > Client Applications > Bluetooth Serial Port > General tab provides options
to configure:

• The application name - to change it, highlight the existing name and enter the new name.

• Secure connection - to enable secure connection, select the option box. To disable secure connection,
clear the option box.

• The communications port (COM port) to be used.

Dial-up Networking

Overview

The Bluetooth Dial-up Networking application allows this computer to use a modem that is physically
connected to a remote device to access the Internet or log on to a remote network.

Note: Unless you have a specific reason to do so, DO NOT CHANGE the default COM Port setting.
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Open a connection to the Dial-up Networking service that is provided by another Bluetooth device using one
of these techniques:

• Notification area, at the far right of the taskbar, Bluetooth icon

• From My Bluetooth Places

• Using the Bluetooth Setup Wizard

After the Bluetooth dial-up networking connection is established it can be used the same way as any other
networking connection. For example, you can open a browser and explore the World Wide Web, if the remote
computer has Internet access.

Close a Dial-up Networking Connection

• In My Bluetooth Places, right-click the service name and select Disconnect.

or

• If the connection was established from the Bluetooth icon in the Notification area, at the far right of the
taskbar; click the Bluetooth icon, select Quick Connect, Dial-up Networking and then select the device that
is providing the service (active connections have a checkmark in front of them).

Configure

The Bluetooth Configuration Panel > Client Applications > Dial-up Networking > General tab provides options
to configure:

• The application name - to change it, highlight the existing name and enter the new name.

• Secure connection - to enable secure connection, select the option box. To disable secure connection,
clear the option box.

• The Bluetooth virtual device (modem) to be used.

Fax

Overview

The Bluetooth Fax service allows this computer to send a fax using a Fax/Modem that is physically connected
to a remote device.

To send a Fax:

1. Open a connection to the Fax service that is provided by another Bluetooth device, using one of these 
techniques:

• Notification area, at the far right of the taskbar, Bluetooth icon

• From My Bluetooth Places

• Using the Bluetooth Setup Wizard
2. Open or create the document to be faxed, and then select the Print, Send to Fax Recipient or a similar 

command that is available in most applications.

Note: Unless you have a specific reason to do so, DO NOT CHANGE the default Bluetooth device
or alter the device's configuration.

Note: The fax application needs to use the Bluetooth Fax Modem.
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Close a Fax Connection

Fax connections close automatically when the Fax transmission is complete.

Configure

The Bluetooth Configuration Panel > Client Applications > Fax > General tab provides options to configure:

• The application name - to change it, highlight the existing name and enter the new name.

• Secure connection - to enable secure connection, select the option box. To disable secure connection,
clear the option box.

Headset

Overview

The Headset application allows this computer to use a Bluetooth headset (or any other device that offers the
Bluetooth headset service) as the audio input and output device for this computer.

Possible uses include:

• If this computer has on-board telephone hardware, a Bluetooth headset might be used as the audio input/
output device to make/receive telephone calls.

• If this computer has voice recognition capabilities, a Bluetooth headset might be used as the audio input
device.

• If this computer has high quality audio capabilities, a Bluetooth stereo headset might be used to listen to
the output.

• Any other scenario that requires audio input/output can potentially take advantage of a Bluetooth headset
to replace a hardwired microphone and/or speakers. 

Create a Headset Connection 

Establish a connection using one of these techniques:

• Notification area, at the far right of the taskbar, Bluetooth icon.

• From My Bluetooth Places.

• Using the Bluetooth Setup Wizard.

Close a Headset Connection

• In My Bluetooth Places, right-click the service name and select Disconnect.

or

• If the connection was established from the Bluetooth icon in the notification area, at the far right of the
taskbar: click the Bluetooth icon, select Quick Connect, Headset and then select the device that is
providing the service (active connections have a checkmark in front of them).

Note: This topic also applies to high quality audio.

Note: Most Bluetooth headsets ring when a connection is attempted; answer the ring to complete the
connection and begin using the headset as the audio input/output device for this computer.
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Configure

The Bluetooth Configuration Panel > Client Applications > Headset > General tab provides options to
configure:

• The application name - to change it, highlight the existing name and enter the new name.

• Secure connection - to enable secure connection, select the option box. To disable secure connection,
clear the option box.

Imaging

Overview

The Bluetooth Imaging application allows this computer to send images to remote devices that provide the
Bluetooth imaging service.

Possible uses include the transfer of images to a Bluetooth camera, camera/phone, or any other device that
offers the Bluetooth Imaging service.

The supported image formats are: 

• BMP

• GIF

• PNG

• JPG

Image Format Conversion

Some devices, particularly battery-powered devices such as phones and cameras, may only be able to accept
images in one format and at a single fixed resolution. In that case, the image is converted to the required format
and resolution before it is transferred to the remote device.

Create an Imaging Connection

Imaging application connections are created automatically on an as-needed basis.

To send an image to the remote imaging device:

• In Entire Bluetooth Neighborhood, drag and drop the image file onto the destination’s device icon.

or

• In Windows Explorer, right-click an image file and, from the shortcut menu, select Copy. Then, in Entire
Bluetooth Neighborhood, right-click the destination device, and, from the shortcut menu, select Paste.

or

• If a shortcut to the remote device’s imaging service exists in My Bluetooth Places, drag and drop, or, copy
and paste, to that shortcut.

Note: Battery-powered remote devices, such as a cell phones or cameras, may require that
Bluetooth be specifically enabled before they can accept an image; see the battery-powered device’s
documentation for more information.
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Close an Imaging Connection

Imaging connections close automatically when the image transfer is complete.

To abort the image transfer, click Cancel in the transfer dialog box.

Configure

The Bluetooth Configuration Panel > Client Applications > Imaging > General tab provides options to configure:

• The application name - to change it, highlight the existing name and enter the new name.

• Secure connection - to enable secure connection, select the option box. To disable secure connection,
clear the option box.

Remote Camera Operation

Remote operation of the Bluetooth imaging device, such as the ability to trip a camera’s shutter or browse the
images on a device, may be possible, depending on the functions supported by the remote device.

There are three prerequisites:

• This computer must be running under the Windows XP operating system.

• The remote imaging device must support the action. See the remote imaging device’s documentation for
information about the remote functions the device supports.

• The remote imaging device must be installed on this computer (see below).

Install an Imaging Device

Perform a search for devices and then, from Entire Bluetooth Neighborhood, right-click a Bluetooth imaging
device, and select Add Camera from the shortcut menu.

Windows installs the camera and adds it to the Cameras and Scanners section of My Computer.

Uninstall an Imaging Device

In Entire Bluetooth Neighborhood, right-click an installed Imaging device and then select Delete Camera from
the shortcut menu.

File Transfer

The Bluetooth File Transfer application allows this computer to perform file operations on the Bluetooth
exchange folder (and the folders and files it contains) of a remote device.

Note: Only Windows XP can install an imaging device; previous operating systems do not have
native support for this option.
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Copy To/From a Remote Device

1. In the Folders pane of Windows Explorer, from the Entire Bluetooth Neighborhood branch, select a device 
and expand that branch to view the File Transfer folder of the remote device.

2. Use drag-and-drop to copy any file or folder contained in the file transfer folder of the remote device to the 
desired folder on this computer.

You can also drag-and-drop files or folders from this computer to the file transfer folder (and its sub-folders) on
the remote device.

Other File Operations

Right-click a file or folder in the remote device’s file transfer folder for a context sensitive menu. All potential
menu options may not be available at all times.

Potential menu options include:

• Open - opens the selected file on this computer, using the default application for this type of file.

• Print - sends the selected file to this computer’s default printer.

• Send To

• 3 ½ floppy (A) - sends the selected  file to the 3 ½ inch diskette drive on this computer

• Bluetooth Exchange Folder - sends the selected file to the Bluetooth exchange folder on this
computer.

• Rename - applies only to empty folders; file names and the names of folders that contain objects cannot
be changed using this technique.

• Cut, Copy, Paste, Delete, Refresh, View, and New - standard Windows functions.

Configure

The Bluetooth Configuration Panel > Client Applications > File Transfer > General tab provides options to
configure:

• The application name - to change it, highlight the existing name and enter the new name.

• Secure connection - to enable secure connection, select the option box. To disable secure connection,
clear the option box.

Network Access

The Bluetooth Network Access application makes it possible for this computer:

• To connect to a Local Area Network (LAN) using the physical connection on a remote Bluetooth device.

or

• To connect to an ad hoc network provided by a remote Bluetooth device. When joining an ad hoc network,
it can take up to one minute after the connection is established to obtain an IP address and automatically
self-configure.

The type of network connection that is available is determined by the configuration of the remote Bluetooth
device.

Note: If File Transfer is not available, the remote device is not configured to allow remote file
operations.
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Create a Network Access Connection

Establish a connection using one of these techniques:

• Notification area, at the far right of the taskbar, Bluetooth icon.

• From My Bluetooth Places.

• Using the Bluetooth Setup Wizard.

Close a Network Access Connection

• In My Bluetooth Places, right-click the service name and select Disconnect.

or

• If the connection was established from the Bluetooth icon in the Notification area, at the far right of the
taskbar; click the Bluetooth icon, select Quick Connect, Network Access and then select the device that is
providing the service (active connections have a checkmark in front of them).

Configure

The Bluetooth Configuration Panel > Client Applications > Network Access > General tab provides options to
configure:

• The application name - to change it, highlight the existing name and enter the new name.

• Secure connection - to enable secure connection, select the option box. To disable secure connection,
clear the option box.

PIM Synchronization

The PIM Synchronization Application is used to synchronize the Personal Information Manager (PIM)
database of this computer with the PIM database of a remote Bluetooth device.

The supported PIMs are:

• Microsoft Outlook

• Microsoft Outlook Express

• Lotus Notes

The supported data types are:

• Business cards

• Calendar items

• Email (with or without attachments)

• Notes

Configure PIM Synchronization

The Bluetooth Configuration Panel > Client Applications > PIM Synchronization > General tab provides options
to configure:

• The application name - to change it, highlight the existing name and enter the new name.

• Secure connection - to enable secure connection, select the option box. To disable secure connection,
clear the option box.

• The PIM items to be synchronized and the PIM on this computer with which those items should be
synced.
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The data item types that can be synchronized are:

• Business cards

• Calendar items

• Email (with or without attachments-see below)

• Notes

Possible synchronization options for each of these data item types include:

• Do Not Synchronize - this item type will not be synchronized.

• Synchronize Microsoft Outlook - this item type will be synchronized with its matching entry in Microsoft
Outlook, regardless of the PIM that contains this entry on the remote device. If a matching Outlook entry
does not exist, it will be created.

• Synchronize Outlook Express - this item type will be synced with its matching entry in Express, regardless
of the PIM that contains this entry on the remote device. If a matching Express entry does not exist, it will
be created.

• Synchronize Lotus Notes - this item type will be synced with its matching entry in Lotus Notes, regardless
of the PIM that contains this entry on the remote device. If a matching Notes entry does not exist, it will be
created.

• Email attachments - the only option is to include or not to include attachments with email that is sent or
received on this computer using this service.

PIM Item Transfer

The Bluetooth PIM Item Transfer application allows this computer to send and receive Personal Information
Manager items to and from a remote Bluetooth device.

The supported items are:

• Business cards (*.vcf or *.vcd)

• Notes (*.vnt)

• Email (*.vmg)

• Calendar (*.vcs)

• Other Types (refer to “Configure Bluetooth” on page 12. Files can be sent by drag and drop on the OBEX
service.)

Item transfer can be accomplished several ways:

• From Windows Explorer, My Bluetooth Places, highlight the PIM Item Transfer service on a remote device,
and then, from the Bluetooth menu on the Windows menu bar, select the appropriate action. 

• From within a supported Personal Information Manager:

• Select one or more items and then, from the PIM's File menu, select Send to Bluetooth.

Note: If synchronization is enabled for a specific item type, but is not enabled for that item type on
the remote device, synchronization will not take place for that item.

Note: Not all choices are available for all items. For example, Note items can only be synchronized
in Microsoft Outlook. Therefore Lotus Notes and Outlook Express are not displayed as options in the
“Notes” item shortcut menu. Personal Information Managers that are not installed on this computer
are not displayed as options in the shortcut menus.
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or

• Drag-and-drop a supported item directly from your PIM to the PIM Item Transfer service icon of a
remote device. 

• For business cards:

• From Windows Explorer, My Bluetooth Places, right-click the PIM Item Transfer service on a remote
device and select the appropriate option.

or

• In the Notification area, at the far right of the taskbar, right-click the Bluetooth icon, select Quick
Connect > Business Card Exchange, select a device from the list, select the appropriate option from
the shortcut menu, and then click OK.

Whether sent items are accepted by the remote device is determined by how the remote device's PIM Item
Transfer service is configured.

Close a PIM Item Transfer Connection

This application closes the open connection automatically when its task is complete.

Configure PIM Item Transfer

The Bluetooth Configuration Panel > Client Applications > PIM Item Transfer > General tab provides options
to configure:

• The application name - to change it, highlight the existing name and enter the new name.

• Enable or disable secure connection - to enable secure connection, place a checkmark in the box.

• How your business card is handled when it is requested by a remote device - the Send My Business Card
options are:

• Choose a business card as needed - each time a remote device requests your business card you
must select a card from your PIM. If you ignore the request the remote device will receive a timeout
notice.

• Always send the same business card - when this option is selected a dialog box is displayed that
allows you to set a default business card that will be sent automatically when requests are received.

• Where to store received business cards. The Received Business Cards options are:

• Microsoft Outlook

• Outlook Express

• Lotus Notes

• Email attachments - the only option is to include or not to include attachments with email that is sent or
received on the computer using this service.

Note: The selected Received Business Cards option does not influence the settings on other PIM-
related property pages. Example: even if the PIM Item Transfer service business card option on this
computer is configured to Do Not Accept, the PIM Item Transfer application will still accept business
cards that the application has specifically requested from its Receive or Exchange functions.
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Printer

The Bluetooth Printer application allows this computer to use a Bluetooth printer.

Once a Bluetooth printer has been properly installed, it can be used from this computer in the same way as
any other printer would be.

Configure

The Bluetooth Configuration Panel > Client Applications > Printer > General tab provides options to configure:

• The application name - to change it, highlight the existing name and enter the new name.

• Enable or disable secure connection - to enable secure connection, place a checkmark in the box.

Install a Bluetooth Printer

Option One:

1. Perform a search for devices and then, from Entire Bluetooth Neighborhood, right-click a Bluetooth printer, 
select Add Printer from the shortcut menu and follow the on-screen instructions.

2. Select the printer make and model at the prompt. If your printer is not in the list of options, click Have 
Disk…, insert the driver disk for the printer, and then navigate to the drive and directory that contains the 
driver initiation file (*.inf) for the printer.

3. Follow the on-screen instructions to complete the installation.

Option Two:

1. From the Windows Control Panel, select Printers > Add Printer > Next > Local printer > Next.
2. On the Select the Printer Port window of the wizard:

• Select Create a new port.

• In the Type shortcut menu, select Bluetooth Printer Port, and then click Next.
3. On the next screen, select the printer by name, and then click Connect. 
4. Install the driver: Select the printer make and model at the prompt. If your printer is not in the list of 

options, click Have Disk…, insert the driver disk for the printer, and then navigate to the drive and directory 
that contain the driver initiation file (*.inf) for the printer.

5. Follow the on-screen instructions to complete the installation.

Delete a Printer

Click Start > Settings > Printers, right-click the printer to be deleted, and then select Delete from the shortcut
menu.

or

In Entire Bluetooth Neighborhood, right-click an installed Bluetooth printer and select Delete Printer from the
shortcut menu.
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BLUETOOTH SERVICES

Common Configuration Settings

These properties can be set individually for each Bluetooth service:

• Service Name - the default name of each service can be changed.

• Secure Connection - requires that remote devices provide proof of identity and that all data be encrypted.

• Startup Automatically - starts the service automatically when Bluetooth is started.

• Notifications - provides visual and/or audio notification that a remote device is attempting to connect (or
has connected) to a service on this computer.

Notifications

There are three types of notification:

• Authentication request, also called a PIN code request - this notification is displayed automatically in a
balloon over the Notification area, at the far right of the taskbar if a Personal Identification Code is required
before a connection can proceed. An audio file can also be associated with the notification.

• Authorization request, also called a connection request - this type of notification can be visual, audio, or
both. It notifies you of attempts to access a Bluetooth service on this computer; the connection will not
proceed until you click the balloon that is displayed  over the Notification area, at the far right of the
taskbar. If the notification balloon is ignored, the connection request will time out and fail.

• Notification only - this type of notification does not affect access in any way; it is solely for information
purposes to let you know that a connection has been established.

Example: Both Authentication and Authorization request notifications are controlled by whether Secure
Connection is enabled for an individual service. An example of how notifications might work when a remote
device attempts to access a service on this computer, if all notifications are enabled:

• Authentication - a balloon notification (audio optional) prompts you for a PIN code. If the PIN code
does not match the code entered on the remote device, the connection will not be allowed. After the
remote device has been authenticated this notification will not appear again, unless the paired
relationship is broken. If the paired relationship is broken, the devices must re-pair.

• Authorization - a balloon notification is displayed and/or a sound file provides audio notification that a
remote device is attempting to access a Bluetooth service on this computer. Click the balloon to
proceed. A dialog box prompts you to enable the connection only once, or to allow this device to use
the service every time.

• After a connection has been authorized, an additional visual and/or audio notification may be
displayed (if enabled). This notification is for information only to inform the operator that a connection
has been established.

Service Access Notification

Notifications lets you associate a sound (Windows *.wav file) and/or a visual indication with access attempts
by remote devices. 

A different notification sound can be associated with each local Bluetooth service.

Note: After two devices are paired, the authentication notification will no longer be displayed when
a connection is attempted. If Always allow… is enabled during the authorization process, the
authorization notification will not be displayed on future connection attempts. Connection notification
only happens if it has been enabled on the Notifications tab of the individual service being accessed.
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Associate a Sound with Service Access

From the Bluetooth Configuration Panel, Local Services tab:

1. Double-click a service name and then select the Notifications tab.
2. Select the options you want; both visual and sound notifications may be selected for a single event.
3. Choose a sound; click the Browse button and navigate to the sound file (*.wav) to be used for notification. 

To preview the sound file, click the play button.
4. Click OK to close the service's property dialog box.

Audio Gateway

The Bluetooth Audio Gateway service enables the computer to use the microphone and speakers on a remote
Bluetooth device as the input and output devices for the computer.

For example, if this computer has voice recognition capabilities, a Bluetooth headset might be used as the
audio input device.

Hardware Requirements

• The Bluetooth hardware on this computer and on the remote device must support audio.

• The remote device handles both audio input and output for this computer; therefore, this computer does
not require a sound card, microphone, or speakers.

Configure the Audio Gateway Service

From the Notification area, at the far right of the taskbar, right-click the Bluetooth icon, select Advanced
Configuration > Local Services, and then double-click the Audio Gateway service.

Set the common configuration properties of the service, and then click OK.

Bluetooth Image Transfer

The Bluetooth image transfer service allows this computer to accept images from remote devices that support
Bluetooth image transfer.

The supported image formats are:

• BMP

• GIF

• PNG

• JPG

Received images are stored in the Bluetooth exchange folder.

Configure the Bluetooth Imaging Service

From the Windows system tray, right-click the Bluetooth icon, select Advanced Configuration > Local Services,
and then double-click the Bluetooth Imaging service.

Set the common configuration properties of the service, and then click OK.
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Bluetooth Serial Port 

The Bluetooth Serial Port service enables a remote Bluetooth device to establish a wireless serial connection
with this computer. The wireless serial connection may be used by applications as though a physical serial
cable connected the devices.

To establish a Bluetooth Serial Port connection:

• The connection must be initiated from the remote device by the Bluetooth Serial Port application.

Determine the communications port being used by this computer for the Bluetooth Serial Port:

• In the Notification area, at the far right of the taskbar, right-click the Bluetooth icon, select Advanced
Configuration, and then select the Local Services tab. The COM port assigned to this service is the last
item in the Bluetooth Serial Port service row. Configure the application on this computer that will use this
service to send its data to this COM.

Add or Delete a Bluetooth Serial Port

The Bluetooth Serial Port service has one pre-configured Bluetooth Serial Port, but additional Bluetooth Serial
Ports can be added as needed.

To add a port:

1. From the Bluetooth Configuration Panel, Local Services tab, click Add Serial Service.
2. In the properties dialog box, modify the properties.

• Enter a unique name (fewer than 99 alphanumeric characters).

• Select secure connection.

• Select Startup Automatically.

• From the COM Port shortcut menu select a communications port that is not assigned to any other
service.

3. Click OK.

To remove a Bluetooth Serial Port:

• From the Bluetooth Configuration Panel, Local Services tab, select the port to be removed and then click
Delete.

Dial-up Networking Service

The Bluetooth Dial-up Networking service makes it possible for a remote Bluetooth device to use a modem
that is physically connected to this computer. The remote device can then access the Internet or log on to a
remote network.

Configure the Dial-up Networking Service

From the Notification area, at the far right of the taskbar, right-click the Bluetooth icon, select Advanced
Configuration > Local Services, and then double-click the Dial-up Networking service.

• Select the physical modem to be used from the Modems - shortcut menu.

• Set the common configuration properties of the service, and then click OK.

Note: The Delete button is only available when a Bluetooth Serial Port is selected.
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Fax Service

The Fax service allows a remote Bluetooth device to send a Fax via a modem that is physically attached to
this computer.

Configure the Fax Service

From the Notification area, at the far right of the taskbar, right-click the Bluetooth icon, select Advanced
Configuration > Local Services, and then double-click the Fax service.

• Select the physical modem to be used from the Modems - shortcut menu.

• Set the common configuration properties of the service, and then click OK.

File Transfer Service

The File Transfer service allows this computer to perform file operations on the Bluetooth exchange folder (and
the folders and files it contains) of a remote device.

To Use the File Transfer Service

1. Right-click the Bluetooth icon and select Explore My Bluetooth Places.
2. Configure Windows Explorer so that the Folders pane is visible (View > Explorer Bar > Folders).
3. In the Folders pane, select Entire Bluetooth Neighborhood.
4. On the menu bar, select Bluetooth > Search For Devices.
5. In the Folders pane, expand Entire Bluetooth Neighborhood to show the devices in the vicinity.
6. Select a device and expand that branch to view the Bluetooth exchange folder of the remote device.

Use drag-and-drop to copy any file or folder contained in the Public Folder of the remote device to a folder on
this computer.

You can also drag-and-drop files or folders from this computer to the Public Folder (and its sub-folders) of the
remote device.

Other file operations - right-click a file or folder in the remote device’s Public Folder for a context sensitive
menu. All potential menu options may not be available at all times.

Potential menu options include:

• Open - opens the selected file on this computer, using the default application for this type of file.

• Print - sends the selected file to this computer’s default printer.

• Send To

• 3 ½ floppy (A) - sends the selected file to the 3 ½ inch floppy drive on this computer

• Public Folder on My Device - sends the selected file to the Public Folder on this computer.

• Rename - applies only to empty folders; file names and the names of folders that contain objects cannot
be changed using this technique.

• Cut, Copy, Paste, Delete, Refresh, View & New - standard Windows functions.

Note: If Public Folder is not available, the remote device is not configured to allow remote file
operations.
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Headset Service

The Bluetooth Headset Service allows this computer to provide audio input/output for remote Bluetooth
devices.

Example: if the remote device is a Bluetooth telephone, this computer’s microphone and speakers can be
used as speakerphone input and output for that device.

Hardware Requirements

• This computer must have a sound card, microphone, and speakers installed.

• The Bluetooth hardware on this computer and on the remote device must support audio.

Configure the Headset Service

• From the Notification area, at the far right of the taskbar, right-click the Bluetooth icon, select Advanced
Configuration > Local Services, and then double-click the Headset service.

• Set the common configuration properties of the service, and then click OK.

Usage Example with a Bluetooth Telephone

From the Bluetooth phone, search for devices that offer the Headset Service, select the Headset Service on
this computer, and then select Connect.

If the Headset Service has Secure Connection enabled, a PIN code and Authorization will be required to
complete the connection.

When the phone successfully connects to the Headset Service:

• In the Notification area, at the far right of the taskbar, the Bluetooth icon will be a blue field with a green
insert (if another Bluetooth connection existed before this connection was established, the icon would
have already been this color).

• A notification balloon will appear briefly above the Bluetooth icon with a message similar to:
Bluetooth Connection Successful 
Bluetooth device My Bluetooth Cell Phone is connected to the Headset service on this computer

The Headset Service now monitors the phone and displays a notification balloon over the Bluetooth icon in the
Notification area, at the far right of the taskbar when an incoming call is detected. Click the balloon to
acknowledge the notification, and then, in the Incoming Call dialog box, click the Accept button to accept the
call.

The audio signal from the phone is re-routed to the audio output device (speakers or earphones) on the
computer, and the microphone on the computer provides the audio input for the phone.

To reject the incoming call, when the Incoming Call dialog box is displayed, click the Reject button.

Note: Individual Bluetooth phone manufacturers may use different terminology to describe the
Headset Service, but the word audio and/or headset should be in the description - refer to the
documentation included with the Bluetooth phone for assistance.
Broadcom Corporation

Page  30 Configure Bluetooth Document 1000-BTW-UM400-R



User Manual BCM1000-BTW
11/12/04
Network Access

The Bluetooth Network Access service enables a remote Bluetooth device to access a Local Area Network
that is physically attached to this computer or allows a remote device to become part of an ad hoc network
provided by this computer.

After this computer has been configured to provide the Network Access service to other Bluetooth devices, it
will not be able to use the Bluetooth Network Access service provided by another Bluetooth device without
being re-configured. In other words, this computer cannot be both a Bluetooth Network Access server and a
Bluetooth Network Access client at the same time.

Setup for Windows 98SE & Windows Me

Configure the server:

1. From Windows Control Panel, double-click the Network icon.
2. On the Configuration tab, select TCP/IP-> Bluetooth LAN Access Server Driver (scroll down if necessary).
3. Click Properties and select the IP Address tab.

• Select Specify an IP address

• Enter an IP Address (suggested value - 192.168.1.1)

• Enter a Subnet Mask (suggested value - 255.255.255.0)
4. Click OK to close each dialog box, and then click Yes to restart the computer.

Setup for Windows 2000 and Windows XP

If Internet Connection sharing was previously enabled (before BTW was installed) it must be disabled and then
re-enabled before the Bluetooth network adapter can use it.

Configure for Internet/LAN:

Before you begin, verify that the:

• Bluetooth software is installed and enabled

• Bluetooth device is turned on

• Server has access to the Local Area Network (LAN). If the LAN provides Internet access, the connection
can be verified by using the server’s browser to connect to the Internet through the LAN.

1. Configure Bluetooth - right-click the Bluetooth icon in the notification area, select Advanced Configuration, 
and then

• From the Local Services tab, select Network Access, and then click Properties.

• From the General tab, in the Select the type of service drop-down list, select Allow other devices to
access the Internet/LAN via this computer, and then in the Connection Sharing section, select
Configure Connection Sharing to display

- Windows XP - the Network Connections window

- Windows 2000 - the Network and Dial-up Connections window
2. Configure Windows

• Right-click Local Area Connection, select Properties, and then

- Windows XP - from the Advanced tab, in the Internet Connection Sharing section, select Allow other

Note: Internet Protocol routing software is required on Windows 98SE and Windows Me servers.
Install and configure the routing software as instructed by the software's manufacturer before you
configure the computer as a Network Access server.
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network users to connect through this computer’s Internet connection. Then select Bluetooth
Connection in the Home Networking drop-down list, if available. (The Home Networking drop-down list
is not available on all versions of Windows XP.)

- Windows 2000 - from the Sharing tab, in the Internet Connection Sharing section, select Enable
Internet Connection Sharing for this connection.

• Click OK to close the window.
3. Click OK in the Bluetooth Properties window to complete the configuration process.

Verify the Server Setup

From a different Bluetooth computer:

1. Find the server - from My Bluetooth Places, in Entire Bluetooth Neighborhood, right-click in an empty 
area, and then select Refresh from the shortcut menu.

2. Display the services - right-click the server and select Discover Available Services from the shortcut 
menu.

3. Connect to the server - double-click the Network Access service and follow the on-screen instructions.
4. Open a browser and connect to the Internet to verify the connection.

PIM Item Transfer

The PIM Item Transfer service allows Personal Information Manager items to be transferred between this
computer and a remote Bluetooth device.

Four data types are supported:

• Business Cards

• Calendar Items

• Email Messages

• Notes

Each data type can be saved in any of the supported and installed PIMs.

When the PIM that is associated with an individual data type is changed on the PIM Item Transfer page, that
data type is also changed for the PIM Synchronization service.

Configure

In addition to the configuration options common to all Bluetooth services, this service also has settings that
determine:

How business card requests are handled. The options are:

• Never send my business card - ignore the request

• Choose a business card as needed - when prompted, select a business card to be sent to the requester.

Note: If a firewall is in use, additional steps may be required before the browser can access the
Internet. Contact your information technology department to determine if a firewall is in use or for
assistance in configuring the Local Area Network settings for your proxy server.

Note: PIMs that are not installed on this computer will not appear in the shortcut menus.
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• Always send the same business card - when a request is received, always send the same business card.
When this option is selected, a dialog box prompts you to select an installed Personal Information
Manager (if more than one is installed on this computer) and an existing business card.

• Previously sent business cards - after a card is selected using the Always send the same business card
option, that card will be added to the shortcut menu as an option.

• Where to store inbound data items, on an individual basis. Options include (not all options apply to all
items):

• Do Not Accept.

• Any of the installed PIMs on this computer.

• Save to Folder.

• The Bluetooth exchange folder location - the directory on this computer where inbound items that are not
to be saved in a PIM will be kept.

• Whether to send/receive attachments with email. 

Close a PIM Item Transfer Connection

PIM Item Transfer connections close automatically when the data transfer is complete.

Default Business Card Selection

When the Always send the same business card option is selected, a dialog box prompts you to select a default
business card.

The first time the dialog box is displayed it provides a way to choose the Personal Information Manager that
stores the default business card. Click the down-arrow in the PIM shortcut menu and select the PIM to be used.

On subsequent appearances of this dialog box, the PIM selection option is not available.

Change the Selected PIM

On the PIM Item Transfer properties page, Received items section, there is a Business Cards shortcut menu.
When a PIM was selected during initial setup the selected item in this menu was set to the same PIM. To
change the PIM used for the default business card, open this shortcut menu and select a new PIM.

Choose a Default Business Card

1. In the Select a Bluetooth Business Card dialog box that is displayed when Always send the same busi-
ness card is selected, select  the card. 

Note: Previously sent business card additions to the menu are limited to ten, after which the oldest
contact will be replaced.

This is also the folder where the File Transfer service stores inbound items. If this folder is 
reconfigured here, it will also be reconfigured in that service automatically.

Note: A new default business card must be selected from the database of the newly selected PIM.
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2. Click OK to choose a selected business card and return to the PIM Item Transfer Properties page. The 
chosen contact is now displayed and selected in the Business card requests shortcut menu.

PIM Synchronization

The PIM Synchronization service can be used by a remote device to synchronize its Personal Information
Manager (PIM) database with the PIM database of this computer.

Four data types are supported:

• Business cards

• Calendar items

• Email messages

• Notes

Whether an individual item is accepted and where it is stored, after it is accepted, is configured in the PIM Item
Transfer service. If that service is not configured to store a particular data type in Outlook, then that data type
cannot be synchronized.

Microsoft Outlook permits duplicate entries, so all duplicates may not be exchanged in the synchronization
process.

Note: Move your mouse over a selected business card to display additional information about that
contact.

Note: In addition to the default menu options, the shortcut menu can hold up to ten contact names.If
the Always send the same business card option is selected again, and a different contact is chosen,
the properties page will display both contacts in the shortcut menu.

Note: Data types that will be synchronized must be saved in the PIM database (this is configured in
the PIM Item Transfer service); otherwise, that data type will not be available for selection (it will be
dimmed) in the PIM Synchronization configuration settings.

Note: Only Outlook’s default contacts folder is synchronized. Items in sub-folders are not
synchronized. Items that are moved from the default folder to a sub-folder will not be displayed the
next time synchronization takes place.
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HARDWARE SETTINGS

The Hardware tab of the Bluetooth Configuration Panel provides basic information about the Bluetooth
hardware installed on this computer and access to the Advanced Settings dialog box, if required:

• Devices:

• Name - the name of the device, e.g., My Bluetooth Device.

• Type - the type of device, e.g., USB.

• Device Properties:

• Device status - indicates that the device is operating properly or that there is a problem/conflict.

• Manufacturer - the name of the company that manufactured the device selected in the Devices section
of this dialog box.

• Firmware Revision - the manufacturer's firmware version number.

• Device Address - the Bluetooth Device Address (BDA or BD_Addr) assigned to this device when it
was manufactured.

• HCI Version - the version number of the Bluetooth Specification that the Host Controller Interface
complies with.

• HCI Revision - the revision number of the Bluetooth Specification that the Host Controller Interface
complies with.

• LMP Version - the version number of the Bluetooth Specification that the Link Manager Protocol
complies with.

• LMP Sub Version - the sub-version number of the Bluetooth Specification that the Link Manager
Protocol complies with.

• Retest Button - Queries the hardware device selected in Devices, and updates the data displayed in
Device Properties.

• Advanced button - displays the Advanced Settings dialog box, which allows you to select the country code
and transmission power settings. This option is not available on all systems.

Advanced Settings

When available, this dialog box is reached from the Hardware tab of the Bluetooth Configuration Panel.

From this dialog box you can set the:

• Country Code

• North America, Europe (except France), and Japan

• France and China

• Maximum Transmission Power

• High

• Medium

• Low

Click Apply to implement the changes. A dialog box is displayed with notification that the Bluetooth device
attached to this computer must be reset before the change(s) will take effect.

Click Yes to reset the Bluetooth device now - all open Bluetooth connections will be closed.

Note: Depending on the country in which the hardware is sold and/or in which it will be used, the
Advanced button may not be present.
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Click No to save the changes - the changes will be applied the next time the Bluetooth device is reset or
restarted.

ACCESSIBILITY SETTINGS

The Accessibility tab of the Bluetooth Configuration Panel lets you specify whether remote devices may access
this computer, which remote devices have access, and whether an audio warning is played when a Personal
Identification Number (PIN code) is required.

Allow Other Devices to Discover this Computer

Select Let other Bluetooth devices discover this computer to permit remote Bluetooth devices to find and report
this computer. If Allow No devices (below) is selected, this option is not available.

Control the Types of Devices that are Allowed to Connect to this Computer

From the Devices allowed to connect to this computer shortcut menu, select:

• No devices - no remote devices are permitted to initiate a connection with this computer. However, this
computer can still initiate connections with remote Bluetooth devices.

• All devices - all remote devices are permitted to connect to this computer. Connections are subject to
additional security restrictions, such as authentication and authorization, which may be required by the
individual services provided by this computer.

• Only devices listed below - only the listed devices are allowed to connect to this computer (see
Accessibility, adding and deleting devices).

Choose an Audio Notification File

When Secure Connection is enabled for any of the Bluetooth services on this computer a PIN code is required
before that service can be accessed. To chose a notification sound that will play when a remote device
attempts to access a service that requires a secure connection, click Select audio file and select the sound
(*.wav) file to be played.

Limit Access to this Computer to Specific Remote Devices

From the Bluetooth Configuration Panel, Accessibility tab, in the Allow menu, select Only devices listed below.

To add a device to the list:

1. Click Add Device
2. In the Devices with access dialog box select the desired devices, and then click OK.

To delete a device from the list:

In the list of devices allowed to access this computer, select the device to be removed from the list, and then
click Delete. 

Note: Multiple devices may be selected using SHIFT + click and/or CTRL + click.
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DISCOVERY SETTINGS

The settings on the Discovery tab of the Bluetooth Configuration Panel determine whether this computer looks
for other Bluetooth devices automatically, how often it looks for devices, and what type of devices it looks for.

Periodic Search for Devices

When Look for other Bluetooth devices is selected, Bluetooth automatically searches for devices every X
minutes. X is a whole number between 1 and 60. To change the time between automatic inquiries, highlight
the existing time and enter the new time.

Determine the Devices that Will be Reported

Bluetooth can screen out devices that you do not need access to.

The options are:

• Report all Bluetooth devices

• Report only selected Bluetooth devices (see Discovery, Adding Specific Devices and Discovery, Deleting
Specific Devices).

Select the preferred option from the drop-down list.

Discover Specific Devices

The type of devices that this computer looks for and reports when it is searching for other Bluetooth devices
can be limited. Limit the remote devices reported:

Bluetooth can report only specific devices, specific classes of device, or specific types of device within a class. 

• Specific devices - an individual computer or Bluetooth cellular telephone are examples of specific devices.

• Specific class of device - computer is an example of a class of devices.

• Specific type of device within a class - laptop is an example of a specific type of device within the
computer class of devices.

The devices to be discovered can be mixed and matched; you can discover one or more specific devices,
classes of devices and types of devices within a class at the same time.

Remove a Device from the List of Devices to be Discovered

In the Bluetooth Configuration Panel, from the Discovery tab, select the device to be removed and click the
Delete button.

Note: When My Bluetooth Places is first opened, it performs an initial automatic search for devices
even if Look for other Bluetooth devices is not enabled.

Note: If Report only selected Bluetooth devices is not selected, the Delete button will not be
available.
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Temporarily Override the Discovery of Specific Devices

In the Bluetooth Configuration Panel, from the Discovery tab, select Report all Bluetooth devices. The
specifically selected devices will be discovered along with all other devices.

To re-enable specific device discovery, re-select Report Only Selected Bluetooth Devices.

SECURITY

AUTHENTICATION

Authentication is used to verify identity; it requires a passkey or link key from the remote device. When a
remote device attempts access, a visual and/or audio warning notifies the local operator.

If the notification is ignored, access is denied after a preset timeout.

When devices are paired, those devices automatically exchange a link key and Authentication is carried out
without operator intervention.

AUTHORIZATION

Authorization is Yes-or-No security that requires operator intervention to avoid having the connection time out
and fail. Authorization is enabled automatically when Secure Connection is enabled, but it can be turned off on
a service-by-service basis for each remote device.

Authorization is limited to:

• Yes, you may connect (click the balloon to proceed).

• No, you may not connect (ignore the balloon prompt and the connection will fail).

When the connection is Authorized, a window is displayed with three Allow access options. This is only for FTP
service.

• For the current task (default) (see note below)

• For the next… (select a time period from the drop-down list box)

• 5 Minutes

• 15 Minutes

• 30 Minutes

• 1 Hour

• Always allow this device to access my computer’s (service name) service.

To set Authorization for multiple local services for a single device:

Note: When all devices are deleted, an error message will appear if Report all Bluetooth devices is
not selected.

Note: Each file, whether sent as a group or individually, is treated as a separate task. When receiving
multiple files, select a For the next...option to avoid having to Authorize each file as it is received.
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1. From My Bluetooth Places, right-click a paired device, select Properties, and then the Authorization tab.
2. Select the services in the list box for which Authorization will NOT be required, and then click OK.

BLUETOOTH DEVICE IDENTITY

Every Bluetooth device has a unique Bluetooth Device Address (BDA) assigned to it during the manufacturing
process. This address cannot be changed.

The BDA is usually displayed in hexadecimal format; 00:D0:B7:03:2E:9F is a valid BDA.

Each Bluetooth device also has a configurable, user-friendly name to help distinguish it from other devices.
The user-friendly name may be up to 99 alphanumeric characters in length and may contain spaces. My
Personal Computer is a valid user-friendly name.

ENCRYPTION

Encrypting data translates it into an unreadable format using a secret key or password. Decrypting the data
requires the same key or password that was used to encrypt it.

LINK KEY

A link key is a unique, internally generated access code based on a passkey, the Bluetooth Device Address,
and an internally generated random number. Link keys are generated automatically when devices are paired.

After a link key is generated, manual entry of the passkey is not required.

PAIRING DEVICES

Pairing allows you to avoid manually entering access information each time a connection is attempted. Paired
devices share a unique link key, which they automatically exchange each time they connect. 

Paired devices attempt to determine the feasibility of an operation before actually executing that operation.

In the following example of a feasibility check, Authorization, which requires the receiving device to approve
the connection (even though the devices are paired), is enabled.

1. A file is selected and sent to a paired remote service.
2. Before actually sending the file, the sending device transparently queries the server.
3. The server transparently replies that it has a file of that name in the folder to which the sender is attempt-

ing to write.
4. The sending device displays a Confirm File Replace window, which the user must acknowledge before the 

connection can proceed.
5. The server displays an Authorization balloon over the notification area, which is located at the far right of 

the taskbar. 

Note: The devices must be paired.
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The server user must acknowledge the Authorization balloon or the connection will fail and the file will not be
transferred.

If there are no duplicate files, the Authorization balloon is displayed on the server immediately.

To Pair with Another Device

If Secure Connection is enabled, the first time two devices attempt to connect, a prompt to pair the devices is
displayed. Follow the on-screen instructions to successfully exchange a passkey and complete the pairing
process.

To pair with a device manually - in the Folders pane of My Bluetooth Places, right-click a device, select Pair
Device from the shortcut menu, and then follow the on-screen instruction.

To Enable or Disable Secure Connection

1. From the Bluetooth Configuration panel, select the Local Services or Client Applications tab.
2. Select or clear the Secure Connection option, and then click OK.

To Remove Pairing

In the Folders pane of My Bluetooth Places, right-click a paired device and select Unpair Device from the
shortcut menu.

PASSKEY

An alphanumeric string up to 16 characters in length. Passkeys are also called Personal Identification
Numbers, or PIN codes.

A passkey may be required if the Secure Connection option is enabled for a Bluetooth service or application.

SECURE CONNECTION

A passkey or link key is required each time a connection is attempted. 

All data exchanged over the Bluetooth connection is encrypted. 

Authorization is also enabled by default when Secure Connection is enabled but Authorization can be disabled
on a service-by-service basis for each remote device that is permitted to connect to this computer.

SECURITY REQUEST DIALOG BOX

A Bluetooth passkey request and/or Bluetooth Authorization request balloon may appear over the Notification
area, at the far right of the taskbar when a connection is attempted if Secure Connection is enabled.

Note: When Secure Connection is enabled on either device, the connection cannot proceed until the
devices are paired.
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Click the balloon to proceed.

TROUBLESHOOTING

CANNOT CONNECT TO A PAIRED DEVICE

Paired devices are always displayed in My Bluetooth Places, even if the remote device is out of range or not
powered on.

• Verify that the remote member of the pair is within radio range, and powered on, and then attempt the
connection again.

CANNOT DISCOVER SERVICES ON AN UNPAIRED REMOTE DEVICE

The remote device may not be powered on or may be out of range.

• Verify that the remote device is turned on.

• Verify that the remote device is in Connectable mode (Bluetooth Configuration Panel > Accessibility tab).

• Perform a Search for Devices to verify that the device is within range.

DIAL-UP NETWORKING SERVICE DOES NOT START

The Dial-up Networking service will not start unless a properly configured modem is attached to the server. 

• Verify that the modem is usable as a local device on the computer to which it is attached.

• In the Bluetooth Configuration Panel, Local Services tab, double-click the Dial-up Networking service.

• Click the down arrow in the Modem field and select the modem that will be used to dial out.

• Click the OK button.

• Click the OK button to close the Bluetooth Configuration Panel.

DETERMINE THE BLUETOOTH DEVICE ADDRESS (BDA) OF MY HARDWARE DEVICE

In the Bluetooth Configuration Panel, on the Hardware tab, in the Devices section, select the device you want
to determine the address of. In the Device Properties section of the dialog box, the fourth entry, Device
Address, is the BDA of the selected Bluetooth device.

DETERMINE THE VERSION OF THE HOST CONTROLLER INTERFACE (HCI)

In the Bluetooth Configuration Panel, on the Hardware tab, in the Device Properties section, the fifth entry
provides Bluetooth Specification compliance information for the Host Controller Interface.

The sixth entry contains the Specification Revision information for the Host Controller Interface, if appropriate.
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DETERMINE THE VERSION OF THE LINK MANAGER PROTOCOL (LMP)

In the Bluetooth Configuration Panel, on the Hardware tab, in the Device Properties section, the seventh entry
provides Link Manager Protocol version number information.

The eighth entry contains the Link Manager Protocol sub-version number information, if appropriate.

FIND INFORMATION ABOUT THE BLUETOOTH HARDWARE ATTACHED TO MY COMPUTER

In the Bluetooth Configuration Panel, select the Hardware tab.

INTERNET CONNECTION SHARING DOES NOT WORK

This occurs because Internet Connection Sharing was enabled when Bluetooth was installed (this is a
Microsoft Windows behavior and is considered proper operation).

To enable Internet Connection Sharing:

• Disable Sharing for the Ethernet adapter

• Select Control Panel > Network and Dial-up Connections.

• Right-click Local Area Connection, select Properties, and then select the Sharing tab.

• Clear the check box for Enable Internet Connection Sharing for this connection, and then click OK.

• Re-enable Sharing for the Ethernet adapter (repeat Step 1.c.), and select (check) the sharing box.

If you are prompted to select an adapter, select Bluetooth network adapter. (This option is not displayed unless
more than one adapter is available.)

If prompted, restart the computer.

TEST A NETWORK ACCESS CONNECTION

If the client is hardwired to the LAN, unplug the hardwired connection to ensure that the test checks the
wireless connection rather than the hardwired connection.

If the server has access to the Internet, open a browser on the client and connect to the World Wide Web.

You may also Ping the server from the DOS prompt.

UNKNOWN PORT MESSAGE WHEN USING A BLUETOOTH SERIAL PORT

The Unknown Port error message usually means an attempt was made to connect a port that was in use.

Additional Bluetooth Serial Ports can be added if they are required.
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BLUETOOTH HEADSET DOES NOT ALWAYS FUNCTION UNDER WINDOWS 98

Windows 98 cannot convert audio files with the extension m3u (e.g., myfile.m3u) into the Pulse Code
Modulation (PCM) audio format used by Bluetooth headsets; this is a limitation of Windows 98.

Other versions of Windows (2000, ME and XP) can translate m3u audio files into the PCM format.

Possible solutions are:

• Upgrade to a newer version of Windows.

• Use an .m3u-to-.mp3 conversion utility to convert the file(s) into a format that is supported by Windows 98.
(Conversion utilities are available as freeware or shareware on the Internet).
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